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Whats New

          Conquest has been around as a computer game since 1990, however this is only the third 
version to be both Microsoft Windows 3.1 and Windows 95 (TM) compatible.    I rewrote the 
program specifically for Windows to take advantage of scrolling displays and better memory 
handling (result: larger maps with 1,000+ territories possible).    Also, Windows standardizes 
interfaces to sound and files, which allows me to incorporate better sound and larger maps.

          Besides Windows, this version of Conquest incorporates Computer Adaptive Players, which
learn from each game they pay, giving you a better challenge.    Other new features are Have 
Computer Finish Your Turn, more Statistics, and better standard computer player algorithms.    In
additions, I have tried to make the display as friendly as possible.    For example, during an attack
you do not have to select Yes to continue the attack, just click on the defender again.

          Best Wishes for many happy hours of strategic gaming!



Instructions

          Conquest has much in common with other Conquer the World games.    Up to 8 players can
play, any or all of whom can be computer controlled.    The goal is to defeat all of the opposing 
armies, and occupy every territory on the Map.    The game objective can be different depending 
on selections made in the game set-up menu.    Conquest is different from other games in this 
genre because of its point & click user interface and the strength of the rule-based algorithm used
by the computer opponents.
          Winning a game of Conquest requires good placement of armies, outnumbering your 
opponent in critical battles, and luck.    Each player's turn is divided into 3 phases: Placement, 
Attack, and Free Move.
          The Placement phase consists of selecting a territory owned by you and putting some or all 
of your new armies for that turn on it.    The number of new armies is determined by the number 
of territories owned by the player and the number of bonus armies received from the occupation 
of whole continents.    This phase continues until all of armies have been placed.
            During the Attack phase, you can attack a bordering territory owned by another player as 
long as you have 2 or more armies on your territory (NOTE:    If you are using the Even Chances 
attack scoring, then your armies must be greater than or equal to your opponent).    If you defeat 
all of the armies on the Defending territory, you can then move some of your armies on to your 
new territory (NOTE:    Each territory must have at least one army at the end of your move). To 
end this phase, select the EXIT box.
            After the Attack phase, a player is allowed to move armies from a territory to an adjacent 
territory, provided he owns both of them.    The purpose of this Free Move is to reinforce your 
current position until your next turn.
            Conquest has a variety of options and settings.    For information on these options, select 
Opening Setup, Game Options, or Players.    For information on starting a game, select New 
Game or Open Game.    For information on how to play the game better, see Hints.



File Menu

Under the File Menu item, there are the following options:

New Game
Open Game
Save
Save As
Copy Map to Clipboard
Print
Quit Game
Exit



New Game

(File Menu item Command)

          To start a game of Conquest, click on the File menu item, and then select New for a new 
game of Conquest or Open to load a previously saved game of Conquest.    If you are starting a 
new game, you will be prompted to review the current game settings.    For information on these 
settings, select Opening Setup, Game Options, or Players.



Open Game

(File Menu item Command)

          To load a previously saved game of Conquest, click on the File menu item, and then select 
Open.    Then select the filename of    game to be restored with the settings which were in effect 
when the game was saved.    See also Computer Adaptive Players.



Save

(File Menu item Command)

          This command saves the current game under the name of the file that you last saved the 
game as.    If you have not saved the game before, you will be prompted for a file name.    See 
also Save As and Computer Adaptive Players.



Save As

(File Menu item Command)

          This command saves the current game under a file name that you select.    See also 
Conquest Files.



Copy Map to Clipboard

(File Menu item Command)

          This command copies the entire map display (at its current resolution and color) to the 
windows clipboard.    This allows you to print the map using the Paintbrush application under 
windows, or insert the map into a document file.



Print

(File Menu item Command)

          This option prints information about the current game.    To print the map, see Copy Map to 
Clipboard.



Quit Game

(File Menu item Command)

          This command allows you to quit your current game of Conquest.    To exit Conquest, select
Exit.



Exit

(File Menu item Command)

        Ends Conquest.



Setup Menu

Under the Setup Menu item, there are the following options:

Opening Setup
Game Play
Players
Show Continent Values
Fit Map to Screen



Options Menu

Under the Options Menu item, there are the following options:

Pause Game
Have Computer Finish Your Turn
Colors
Font
Lines
Sound
Speed
Zoom
Save Configuration



Opening Setup

(Setup Menu item Command)

The Opening Setup determines how Conquest will start a game.    To edit these settings, 
select the Options menu item, and then select Opening Setup.    The options that are under the 
Opening Setup are:

Game Objective
Territory Selection
Minimum Number of Starting Armies
Maximum Number of Starting Armies
Random Player Order
Lock Game Settings



Game Objective

This is the condition that determines the end of the game, and selects the winner.    
Possible settings are:      This is the condition that determines the end of the game, and selects the 
winner.    Possible settings are:

Conquer All Territories
Conquer 60%% of Territories
Conquer 75%% of Territories
Conquer 90%% of Territories
Most Armies After 10 Rounds
Most Armies After 15 Rounds
Most Armies After 20 Rounds
Most States After 10 Rounds
Most States After 15 Rounds
Most States After 20 Rounds



Territory Selection

This option determines how the territories are initially selected for each player at the start
of the game.    Settings are

Random - Territories are automatically picked for each player on a random basis.
Partitioned - Similar to the first method, however territories are clustered for each

player, so the starting position is better.
Manual - All territories and number of armies are determined by the Human

players.
Player's choice - Each player picks his own.



Minimum Number of Starting Armies

This setting determine the minimum number of starting armies on each territory at the 
start of the game.



Maximum Number of Starting Armies

This setting determine the maximum number of starting armies on each territory at the 
start of the game.



Random Player Order

If this option is selected, the order the players play each round is changed for the next 
round.    For example if you are playing a three player game with players 1,2, and 3.    In the first 
round, the order of players might be 1,2, then 3.    For the next round, it could be 3,1, then 2.    If 
this option is not selected (default setting), then the player order is not changed after the start of 
the game.



Lock Game Settings

If this option is checked, then the Game Options can not be altered once a game has 
started.



Game Play

(Setup Menu item Command)

This is the condition that determines how the game is played.    Possible settings are:

Attack Scoring
Bonus Armies
Free Moves
Rebellions
Continent Blockades
Minimum Number of Armies / Turn
Maximum Number of Armies / Turn
Maximum Number of Armies / Territory
Territories Required to Award a New Army
Random Plagues
Hide Non-adjacent Opponents Territories
Penalty for Attacking New Continent



Attack Scoring

This option determines how battles are won or lost by the participating territories.    
Settings are:

Even Chances - even odds for the attacker and defender.    To attack, an attacker
must have the same or more armies than the defender.

Weighted by # of Armies - odds for each battle favor the player with the most
armies on his territory (but independent of armies he owns elsewhere).

Wildly Random - unpredictable.
Cyclic (Short or Long) - your odds of winning depend on a biorhythm cycle.
Simulated Dice Toss - uses dice (see guide).
Unknown - randomly chooses one of the above.
Pure Logic - Each attack costs each player the same number of armies (not

random).



Bonus Armies

Bonus Armies For Each Opponent Eliminated gives new armies to a player if he 
removes another player from the game.    Settings are:

Fixed at 5 - Every time a player is eliminated from the game, the player that won
the last battle with the eliminated player gets 5 armies to immediately place
on his or her territory.

Fixed at 10
Fixed at 15
Escalating (By 5)    - Each successive player eliminated increases the number of

bonus armies awarded
Escalating (By 10)
None



Free Moves

This setting determines how and when a player can redistribute his armies at the end of 
his turn.    A player's free move can be dependent on if he conquered a territory during his turn.    
Settings are:

One Each Turn
Two Each Turn
Unlimited Each Turn
One After Successful Attack
Two After Successful Attack
Unlimited After Successful Attack
None

If the Paratroopers box is not checked, the territories involved in the free move must 
border each other (this is the default setting).    If the Paratroopers box is checked, then a player 
can move armies between any of his territories (regardless of whether they border each other or 
not).



Rebellions

Rebellions enables territories to change owners during the game without combat.    If 
Strong to weak is selected, then the player with the best position will lose territories to the 
player with the worst position (at random intervals.    Settings are:

Rare/Strong to Weak/Single Territory
Rare/Weak to Strong/Single Territory
Rare/Random/Single Territory
Rare/Strong to Weak/Few Territories
Rare/Weak to Strong/Few Territories
Rare/Random/Few Territories
Rare/Strong to Weak/Cluster of Territories
Rare/Weak to Strong/Cluster of Territories
Rare/Random/Cluster of Territories
Often/Strong to Weak/Single Territory
Often/Weak to Strong/Single Territory
Often/Random/Single Territory
Often/Strong to Weak/Few Territories
Often/Weak to Strong/Few Territories
Often/Random/Few Territories
Often/Strong to Weak/Cluster of Territories
Often/Weak to Strong/Cluster of Territories
Often/Random/Cluster of Territories
None

Rare or Often determines how likely a rebellion is.    The next setting controls what player
will have a rebellion.    The last setting controls how many territories will be involved in the 
rebellion.



Continent Blockades

If Continent Blockades are enabled, then attacks between territories in different 
continents are periodically not allowed.    The lines connecting adjacent continents are removed 
during a blockade unless the box labled Redraw Map to Remove Connectors During a Blockade 
is not checked.    Settings are:

Random (Low Probability)
Random (Medium Probability)
Random (High Probability)
Every Other Turn (1 of 2)
Every Fourth Turn (1 of 4)
Every Tenth Turn (1 of 10)
None

Redrawing the map to show continent blockades takes some time, so you may wish to 
uncheck the Redraw Map to Remove Connectors box if you use Continent Blockades for most
of your games.



Minimum Number of Armies / Turn

This option sets the minimum number of new armies awarded to each player at the start 
of their turn.    See also New Armies.



Maximum Number of Armies / Turn

This option sets the maximum number of new armies awarded to each player at the start 
of their turn. See also New Armies.



Maximum Number of Armies / Territory 
This option sets the maximum number of armies allowed to occupy a territory.    If 

additional armies are placed on a territory already holding the maximum number, then those 
armies are lost.



Territories Required to Award a New Army

This option determines how many new armies are awarded based on the number of 
territories owned by a player at the start of his turn.    For example, if a player owns 12 territories,
and this option is set to 3, then that player would receive at least 4 new armies at the start of his 
turn (he or she may receive more if they own an entire continent). See also New Armies.



Random Plagues

Randomly reduces the armies on a heavily defended territory to 1.    Strikes the
most occupied territory about every third turn.    Ownership of the territory does not change.



Hide Non-adjacent Opponents Territories

If Hide Non-Adjacent Opponent's Territories is checked, then all of the territories not 
next to a human player will be covered.    This makes the game more adventuresome for human 
players, by forcing them to hold individual territories in several continents in order to gauge the 
strength of computer opponents.



Penalty for Attacking New Continent

If Penalty for attacking a new continent is on, an attacker has a %33 less chance of 
winning a battle if the defender is part of different continent.



Pause Game

(Options Menu item Command)

This menuitem halts the play of the game until it is disabled.    This is useful if you want 
to change or view several settings during a computer players turn.



Players

(Setup Menu item Command)

The player settings determine how many and what type of players will play a game of 
Conquest.    To edit player settings, select Options then the Players menuitem.    The first dialog 
box shows all of the current settings and if the players will play in Team Play or not.    To edit a 
players settings, select edit.    For more information, select Player Settings. If a player is active 
(will participate in the game), then the box next to a players name and type are will be checked.   
To play a game, at least 3 players must be active.



Team Play

Team play allows groups of players to band together and battle other teams.    In the Team
options menu, you assign a team number to each player.    You can have as many or as few 
members in each team.    Team members split the new armies for each turn (no matter what their 
individual territorial holdings are).    Human team members can attack other team members - 
however, except to make a path for your armies to get to the front, there is no reason to attack a 
teammate.    The game's outcome is decided by the team's
standing, not the individual players.

Each team member can only use his own territories to play.    You can not place armies on
a teammate's territories, etc.



Player Settings

There are four types of players: Humans, Computer Players, Modem (remote) 
Players, and Computer Adaptive Players.    Computer and Computer Adaptive opponents use the 
other settings in this box (such as Strategy, Philosophy, Attack Priority, and Intelligence.    
Modem (remote players) are not supported in this version of Conquest.    Computer Adaptive 
players learn from each game of Conquest, and attempt to use this knowledge to play better in 
the next game.    It is not recommended that you use more than one Computer Adaptive player in 
each game, because they could learn the wrong things from each other.    It is also recommended, 
but not required, that you use at least one human player when you use Computer Adaptive player
so they can learn from the best player.    The Computer Adaptive player saves the information in 
a file with the same name as the map in use (the information a Computer Adaptive player learns 
is map dependent) and with the extension .adt.    If the box labeled Occasionally Cheat During 
Attack on Human Player is checked, then the player (can be any type) will have a %12 advantage
in combat with human players.    The primary objective on including this option is to make 
Computer Players more challenging to advanced human players.    It can also be used to help a 
weaker human player playing with stronger human players.



Strategy

Strategy determines how the computer attacks during the attack phase.

Standard plays the opponent as in previous versions of Conquest
(recommended setting).

Blitzkrieg encourages the computer player to go around strongholds, and
attack at the weakest points.

Maginot Line encourages the player to attack the enemy at his strongest
points (to wear them down), and to concentrate his efforts on
defending his continents.



Philosophy

Philosophy sets the basic principle the computer opponent will use to place armies and 
initiate attacks.

Aggressive - attacks often.
Defensive    - hordes armies.
Balanced      - mixture of the above.
Random          - changes each turn.



Attack Priority

This setting determines who the computer opponent is most likely to attack if all other 
conditions are equal.    In other words, if a player can attack two different territories
owned by two different players, and the advantage gained from conquering each territory
is the same, the computer player will prefer attacking the one corresponding to the selection here.
The recommended setting (for long games) is Strong Players. The Vengeance setting causes the
computer player to attack the player (any type) that has attacked him the most.



Intelligence

Intelligence goes from one to ten, and it determines how a computer player plays. Dumb 
players (Intelligence less than three) can still win, but they do not make as much of a challenge 
as the smart players.



Show Continent Values

(Setup Menu item Command)

If this menuitem is selected, then the number of armies awarded at the start of a turn to 
the owner of the entire continent is shown circled next to the continent.



Fit Map to Screen

(Setup Menu item Command)

This option will attempt to stretch or shrink the map to the window size in use.    
Conquest maps are a series of lines in which color is poured (using the Windows floodfill 
function).    If a gap appears in the border of a territory, perhaps caused by shrinking a map to the 
point where the number of armies overlaps the territorys borders, then the color of the territory 
will leak into an adjacent territory.    If this happens, it will become very difficult to determine 
who owns a particular territory.    To fix this, select Help and then Restore Map. See also Zoom 
and Trouble Shooting.



Colors

(Options Menu item Command)

To edit the Colors used by the players and the map, select Options then Colors. 
Conquest will let you select any colors for any element of the game, however some colors will 
not yield satisfactory results.    For example, if you select a players color the same as the map 
border color, Conquest will not be able to fill that players territories with the correct color.    
Solid (non-dithered) colors work the best.    See also Trouble Shooting.



Font

(Options Menu item Command)

The Font determines the size, color, and Font used by the numbers representing the 
number of armies in a territory.    It is important to use the smallest number practical to prevent 
overwriting the border of the territory and allowing its color to spill into its neighbors.    If this 
happens, select a smaller Font, and then select Help then Restore Map. See also Fit Map to 
Screen.    See also Trouble Shooting.



Lines

(Options Menu item Command)

This option controls the thickness of the lines used to draw a Conquest Map.



Sound

(Options Menu item Command)

This option enables or disables all Conquest Sounds.    Conquest Sounds are located in 
the file WINCONQ.INI under [sounds].    Conquest default sounds are:

Conquest Welcome - "Welcome.wav"
Conquest Farewell - "Farewell.wav"
Conquest Registration - "Thanks.wav"
Conquest Human Game Won - "Crowd.wav "
Conquest Comp Game Won - "Death.wavn"
Conquest Player Killed - "Death.wav "
Conquest New Round - "<none> "
Conquest Rebellion - "Rebel.wav "
Conquest Plague - "Plague.wav "
Conquest Blockade - "Blockade.wav"
Conquest Beep - "Ding.wav"
Conquest Human Battle Won - "Laser.wav"
Conquest Human Battle Lost - "Miss.wav "
Conquest Comp Battle Won - "Laser.wav "
Conquest Comp Battle Lost - "Miss.wav "
Conquest Capture Territory - "Tada.wav"
Conquest Capture Continent - "Bell.wav"

You can change any or all of these sounds to any *.wav sound you wish, as long as it is in
the Conquest directory, and replaces one or more of the above files.



Have Computer Finish Your Turn

(Options Menu item Command)

This item will have the computer finish you turn, regardless of the phase you are in.    
This is useful for some of the larger maps, where you may not wish to spend much time on 
completing one of the many turns.    After the computer finishes your turn, the player will be 
reset to human for the next turn.    The settings used by the computer to finish your turn are 
defensive with average intelligence.    For more information, see also: Player Settings



Speed

(Options Menu item Command)

This option determines the speed of the Conquest timer.    The typical value is every 300 
milliseconds (about a third of a second), Conquest performs a task.    If you make this setting 
slower (increments of 100 milliseconds), then other programs you are running will have more 
time to perform their tasks.    If the setting is set too fast for your computer type, then Conquest 
will saturate your systems resources, and make it difficult to perform other tasks.    The option 
Fast cursor detection determines the location of your mouse cursor by its proximity to a territorys
army number.    If this option is not checked, then Conquest searches each territory to find the 
cursor (more accurate, but slower).    If Pause Game When Minimized is not checked, then 
Conquest Computer Players continue to play even though the application has been shrunk to an 
icon (minimized).    If Synchronized Sounds is checked, then the sounds are linked tightly to 
each event which slows down the play of Conquest, but makes sure each sound is completely 
played.



Zoom

(Options Menu item Command)

This option will attempt to stretch or shrink the map to the size you wish.    Conquest 
maps are a series of lines in which color is poured (using the Windows floodfill function).    If a 
gap appears in the border of a territory, perhaps caused by shrinking a map to the point where the
number of armies overlaps the territorys borders, then the color of the territory will leak into an 
adjacent territory.    If this happens, it will become very difficult to determine who owns a 
particular territory.    To fix this, select Help and then Restore Map. See also Fit Map to Screen.



Save Configuration

(Options Menu item Command)

This option saves all game and player settings as the default settings for a new game of 
Conquest.



Statistics Menu

Conquest has many in-game statistics to help you with your strategy.    Specific statistics 
are:

Bar Chart
Pie Chart
Numbers
Graphs
Attackers
New Armies
Map
Game Victories

To view a statistic, select Statistics and then the corresponding menuitem to the statistic 
you want to see.



Bar Chart

(Statistics Menu Item Command)

This item creates two charts.    The left chart shows the relative numbers of armies owned 
by each player, and the right chart shows the relative numbers of territories owned by each 
player.    These charts are relative in the sense that the maximum number is used to normalized 
each of the other amounts.    The order of the bars is the players rank.    See also: Bar Chart



Pie Chart

(Statistics Menu Item Command)

This item creates two charts.    The left chart shows the relative numbers of armies owned 
by each player, and the right chart shows the relative numbers of territories owned by each 
player.    These charts are relative in the sense that the maximum number is used to normalized 
each of the other amounts.    The area of each slice of the pie is the relative standing of that 
player.    See also: Bar Chart



Numbers

(Statistics Menu Item Command)

This item shows numbers in amounts or percentages (user selectable) for the number of 
armies, territories, attacks won, and attacks lost for each player.



Graphs

(Statistics Menu Item Command)

This statistic plots the number of armies and territories owned by each player for each 
turn.



Attackers

(Statistics Menu Item Command)

This statistic plots the number of battles each player initiated against each of the other 
players.



New Armies

(Statistics Menu Item Command)

This statistic shows the number of new armies that would be awarded to a player at the 
start of his turn based on current standings.



Map

(Statistics Menu Item Command)

This statistic shows the number of territories and continents as well as the original size of 
the map.



Game Victories

(Statistics Menu Item Command)

This statistic show the number of games that each of the current players have won.    
Game victory statistics are collected based on players name, so you should customize your 
favorite players by changing their name to one of your own choosing.



Help Menu

The Help menuitem has several options. Help! brings up the Help display.    Registration 
brings up information on how to register Conquest.    Reset Sound restores the sound settings in 
the WIN.INI to their original Conquest settings.    Redraw Map quickly refreshes the Conquest 
display.    Restore Map reinitializes the Conquest display.    About displays information on the 
current version of Conquest.    See also Trouble Shooting.



Registration

(Help Menu Item Command)

If you have registered a previous version of Conquest, then you are pre-registered for this
version.    Select Help then Registration and enter your password.    That is all you need to do!    
If you have not registered Conquest, then you need to register before you can use maps other 
than Conquest.map or Conqmap.map.    Follow the instructions on the screen - you can print a 
form if you wish.    Please address your registration to:

David Burns
Dept: Conquest for Windows
P.O. Box 1112
Fairborn, OH    45324-1112

Registration costs $20, and brings you 100 maps and a program to make your own maps 
(currently DOS based - although it makes maps that run on Conquest for Windows).    If you are 
registering Conquest from outside of North America, please add $1 for extra shipping costs.    
Thanks!



Extraneous

I think the most challenging setting is: one human, 3 or more smart computer opponents 
with a Computer Adaptive Player on a large map (more than 75 territories).    Even more difficult
is teaming the computer opponents against unteamed human players.

If the attack scoring is set to Weighted by number of armies, the weak computer players
will do better because they tend to put all of their armies in one or two territories.

If you are having too much trouble beating the computer opponents, set the Favors 
Attacking selection to Computer Opponents so they will give you more breathing room.    
Also, set the intelligence level above 7 so they do a better job of beating up each other.



Hints

Most placement and attack decisions are a trade off between conquering a continent (to 
obtain the new armies awarded for owning that continent), and defending your position.    The 
algorithm for the computer opponents balances a desire to occupy entire continents with a 
paranoia of attacks from other players (be they human or computer).

The advantage of setting the Favors Attacking player selection to Strongest
player is the computer opponents will keep each other (and the humans) in check.    If a
computer opponent feels that another player is getting too strong, he will shift his
focus slightly to weaken the adversary. 

To decide which continent is best for placing armies in (and attacking in), consider
how many territories you own in it, and how difficult it is to obtain and defend.    Usually
the higher value continents are more difficult to get and keep.

Try to place your armies in an area that the other opponents are not trying to conquer.      
Sometimes it is possible to win by collecting armies and letting your opponents weaken each 
other.

Try not to attack each turn to the point you can not attack anymore.    This keeps enemies 
from taking your territories too easily.

Sometimes you may need to sacrifice part of your forces to keep your opponent(s) from 
controlling a complete continent.    Consider placing a few armies on one or two remote 
territories even if you do not want to acquire that continent in the near future.    This makes the 
other opponents work harder to improve their positions.

Check Statistics to gauge how your opponents are doing.    If one opponent is getting too 
strong, try to concentrate your attacks on him.    Even though he may help you in the short run by
weakening the other opponents, sooner or later he will come after you.

Use a variety of computer opponents, including the Aggressive type.    The computer 
opponents do not recognize if the defender is human (unless you set the favors attacking to 
human), instead they try to concentrate their attacks on territories they want to occupy and 
opponents they perceive are threatening their position.

If you use the Weighted by # of Armies attack scoring option, then attack any time you 
have more armies than an opponent, even if you do not want that territory.    This allows you to 
reduce your opponents armies when the odds favor you.

Use more than one type of Territory placement to make a map more interesting.
If you want to reset the game to its original configuration, just delete the file

'WINCONQ.INI' from your disk.    This file is created by the game when you save the current 
game setup.    Your password is also stored in this file, so make sure you have it written down 
before you delete the file.

See also Extraneous



About Conquest

              Version: 1.2
                    Code:    182,334 lines of Borland C++ 4.52
    Algorithm:    Adaptive Rule-based system
                                          for each computer opponent type with file storage of lessons learned.
    Dev Envir:    120 MHz Pentium w/ 16 Megs of RAM (just improved!).
      Released:      July 20, 1996



Placement

At the start of each turn, a player is given new armies to place on any of his territories.    
To place the armies, just point to the territory, and click the LEFT mouse button.    Then select 
the number of armies to place on that state.    The program will not let you select a territory that 
does not belong to you.

The number of new armies is derived from the total number of territories owned by you 
divided by Territories Required to Award a New Army, plus additional armies for each continent 
you own (the armies gained by owning a continent are displayed by selecting Show Continent 
Values).    At least the Minimum Number of Armies / Turn will be awarded and not more than the
Maximum Number of Armies / Turn will be awarded to a player each turn.



Attack

The Objectives of Conquest are to occupy more territory or amass more armies than your 
adversaries.    To do that, you need to conquer critical territories (take other players territories) to 
occupy entire continents and gain extra New Armies.    The way you do this is by attacking.

To attack, just click on your territory (the Attacker), and then on the territory you wish to 
attack (the Defender).    If you can attack it, the attack will automatically take place.    If one of 
your territories does not border any of your opponents, or the attacker does not border the 
defender, you will not be able to select it.    To continue to attack (if it is possible), select Yes 
from the toolbar or click on the Defender again.    To attack somewhere else, select a different 
territory, or select No from the toolbar.

Attacks can only occur between bordering territories.    A white line representing a sea 
lane also indicates which territories border each other.

To exit this mode, select Exit.



Free Move

At the end of each turn, a player may move armies from one territory to another, provided
he owns both of them.    This allows each player to reinforce his position after he has completed 
the attack phase.    After the free move, at least one army must remain on each territory. 

To make a free move, just select the territory to move the armies from (the Donor), and 
then select the territory you wish to move to (the Receiver).    You will then be prompted for the 
number of armies to move.    If only one army can be moved, the move will be automatic.    If 
you wish to abort the free move after you are prompted for the number of armies, select zero.    
See also Free Moves.



Conquest Files

Conquest comes with the following files:

WINCONQ.EXE - main program
WINCONQ.INI - configuration file for game
BWCC.DLL - Custom Controls DLL
BC450RTL.DLL - Run Time Library for program
WINCONQ.HLP - help file text
WINCONQ.LOG - record of game winners
*.WAV - sound files for Conquest events
*.MAP - game map files
*.SAV - saved game files
*.TMP - temporary files for Computer Adaptive Players
*.ADT - Computer Adaptive Player lessons learned

Conquest also writes its sound configuration files to the WIN.INI file.



Computer Adaptive Players

Computer Adaptive Players keep records of each game of Conquest in which they 
participate.    During the game, they create a file with the prefix of the maps name, and the 
extension *.tmp (for example CONQMAP.TMP) in the map directory.    After the game, if you 
decide to update the computer adaptive player (you will be prompted at the end of the game), the
file is condensed into another file with the extension *.adt (for example CONQMAP.ADT)    or 
update the file if it already exists.

The adaptive players work by keep track of the strategies used by the winning player, and
trying to follow that strategy in their own games.    Specifically, the adaptive player tries to 
determine the most important continents and army strengths used by the winner at certain critical
turns.    As a result, this information is tightly linked to each map (because each map has a 
different number of territories and continents).    These files are text-based, so you can read them 
with the Windows Notebook or another word processing software.

Because the adaptive players use a file to keep track of the current game, they can not be 
saved (because the file could be changed in a different game) and replayed later.    Games saved 
with computer adaptive players will have those players changed to computer players only when 
they are restored at a later date.    If a game with adaptive players is saved it will not interfere 
with the adaptive players for the rest of that game.

For these players to work the best, they need to learn from the best players, so give them 
challenging opponents (human, if possible!) so they can learn the best strategies.

Although the adaptive players attempt to apply what they have learned after only the 
second game (until then, they are just another computer player), they do not reach peak 
performance until after the 6th or 7th game.    See also Players.



Trouble Shooting

Display Problems:

The most likely problem you will face will be a problem with the Conquest Map picture 
in your window.    Conquest draws the display by first drawing lines on the screen, then filling 
the lines with color representing the owner of the territory, and then Conquest places the number 
on the territory representing the number of armies.    Potential problems are listed below, along 
with a numbered reference for solving the problem.    Try each of the solutions one at a time until
the problem is fixed

Problem Solution

Territory has the wrong color 1,2,3,4
Shadow of old territory number appears 2,5

under current number
Ocean color changes to color of a player 2,3,4
Human player is unable to select a 1,2,3,4,6

territory
Map was accidentally zoomed too small 2

to see.
Conquest takes up too much time on 7

my machine when paused

Solution Reference

1.    Redraw Map      (see Help Menu)
2.    Restore Map      (see Help Menu)
3.    Change to a smaller Font.
4.    Change Border Line Thickness to Thick.
5.    Restore Colors to original configuration
6.    Under the Speed menu, check Enable Fast Cursor Detection
7.    Under the Speed menu, check Pause Game when Minimized, and/or select a slower speed 
setting.

See also Zoom

Sound Problems:

If you are switching to Windows 95, you may have trouble with the sound files associated with 
Conquest.    You may need to reinstall Conquest (which reloads the sound files) so Conquest will 
be able to find the sound files.    See also Sound




